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ABSTRACT 

The background of this study is the discrepancy in the calculation of deforestation and forest degradation areas reported 

by the Ministry of Environment and Forestry (MoEF) and the Tropical Moist Forest (TMF) version. The research method 

involves analyzing deforestation and forest degradation data provided by the MoEF and the TMF version from the 

European Commission’s Joint Research Centre. Based on the results, there are differences in the total area of deforested 

and degraded forest. For the 2018–2019 period, deforestation according to the MoEF map was approximately ±42.59 

hectares, while the TMF map reported ±47.73 hectares. In the 2019–2020 period, deforestation according to the MoEF 

map was ±672 hectares, while the TMF map reported ±16.14 hectares. For the 2020–2021 period, deforestation based on 

the MoEF map was ±61.05 hectares, compared to ±41.67 hectares according to the TMF map. For the 2021–2022 period, 

deforestation based on the TMF map was ±25.00 hectares. Regarding forest degradation, in the 2018–2019 period, the 

TMF map recorded ±293.55 hectares. For the 2019–2020 period, the MoEF map recorded ±64.59 hectares, while the 

TMF map reported ±109.00 hectares. Forest degradation in the 2020–2021 period according to the TMF map was ±54.00 

hectares, and for the 2021–2022 period, the TMF map reported ±93.00 hectares. 

Keywords: Deforestation, Forest degradation, Land cover, Tropical moist forest. 

ABSTRAK 

Latar belakang penelitian ini adalah terdapatnya perbedaan perhitungan luas deforestasi dan degradasi hutan yang 

dikeluarkan oleh Kementerian Lingkungan Hidup dan Kehutanan (KLHK) dan versi Tropical Moist Forest (TMF). 

Metode penelitian ini yaitu menganalisis data deforestasi dan degradasi hutan yang dikeluarkan versi KLHK dan versi 

TMF dari The European Commission’s Joint Research Centre. Berdasarkan hasil yang diperoleh terdapat perbedaan 

jumlah luasan area terdeforestasi dan area hutan terdegradasi, deforestasi periode tahun 2018-2019 versi peta KLHK 

seluas ±42,59 hektar, angka deforestasi versi peta TMF seluas ±47,73 hektar. Luas deforestasi periode tahun 2019-2020 

versi peta KLHK seluas ±672 hektar dan versi peta TMF seluas ±16,14 hektar. Deforestasi periode tahun 2020-2021 

versi peta KLHK seluas ±61,05 hektar, dan versi peta TMF seluas ±41,67 hektar. Deforestasi periode tahun 2021-2022 

versi peta TMF seluas ±25,00 hektar. Degradasi hutan periode tahun 2018-2019 versi peta TMF seluas ±293,55 hektar. 

Luas degradasi hutan versi peta KLHK periode tahun 2019-2020 seluas ±64,59 hektar, dan luas versi peta TMF seluas 

±109,00 hektar. Degradasi hutan periode tahun 2020-2021 versi peta TMF yaitu seluas ±54,00 hektar. Degradasi hutan 

tahun 2021-2022 versi peta TMF seluas ±93,00 hektar. 

 

Kata kunci: Deforestasi, Degradasi Hutan, Hutan Tropis Lembab, Tutupan Lahan. 

 

PENDAHULUAN 

 

Kementerian Lingkungan Hidup dan 

Kehutanan, menyebutkan bahwa kawasan hutan 

Indonesia memiliki luas ±120,2 juta ha. 

Berdasarkan luasan tersebut, ±88,4 juta ha telah 

selesai ditetapkan sebagai kawasan hutan oleh 

Menteri Lingkungan Hidup dan Kehutanan. Dengan 

demikian seluas ±31,8 juta ha kawasan hutan 

Indonesia, masih berstatus penunjukan atau baru 

selesai dilakukan kegiatan penataan batas dan 

pemetaan. Selain luas kawasan hutan, hal lain yang 

juga menarik di dalam buku ini adalah informasi 

adanya peningkatan luas lahan berhutan di 

Indonesia yang mencapai 1,4 juta ha pada periode 

2019-2020 (Liyantono dkk., 2022) 

Kementerian Lingkungan Hidup dan 

Kehutanan juga melaporkan bahwa deforestasi atau 

hilangnya hutan alam primer dan sekunder di 

Indonesia pada periode 2018-2019 mencapai 462,5 

ribu ha. Sementara pada periode 2019-2020 

dilaporkan telah terjadi deforestasi seluas 115,5 ribu 

ha. Berdasarkan data di atas, deforestasi di 

Indonesia diklaim turun sebanyak 75%. Angka 

deforestasi di Indonesia tidak selalu turun namun 

bersifat fluktuatif. Pada periode 2016-2017, 
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deforestasi dilaporkan mencapai 480 ribu ha, jauh 

lebih tinggi dari deforestasi pada periode 2018-2020 

(Liyantono dkk., 2022). 

Kemajuan teknologi penginderaan jauh 

khususnya satelit memberikan akses kepada banyak 

pihak baik di dalam maupun di luar negeri untuk 

melakukan analisis guna memperoleh data luas 

areal berhutan maupun luas deforestasi di suatu 

wilayah. Berbagai metode analisis citra satelit telah 

dikembangkan untuk menghasilkan informasi di 

maksud yang setidaknya terbagi menjadi dua 

pendekatan (approach) yakni metode interpretasi 

manual dan metode interpretasi secara otomatis 

menggunakan algoritma yang diproses dan 

dijalankan oleh perangkat komputer. Selain 

perbedaan metode, pilihan terhadap citra satelit 

yang digunakan adalah sumber variasi lain yang 

juga dapat menyebabkan perbedaan hasil analisis 

areal berhutan dan deforestasi di suatu wilayah. 

Hutan tropis di Asia Tenggara termasuk 

Indonesia menarik untuk dipantau 

perkembangannya oleh masyarakat internasional, 

karena kontribusinya dalam menjaga iklim global 

yang telah mengalami perubahan akibat kegiatan 

manusia yang menghasilkan emisi gas rumah kaca 

ke atmosfir bumi. Tidak mengherankan apabila 

selain KLHK, banyak lembaga internasional yang 

juga melakukan perhitungan luas hutan maupun 

juga luas deforestasi yang terjadi di Indonesia. Pada 

tahun 2019, The European Commission’s Joint 

Research Centre (2022) merilis angka luas hutan 

Indonesia yang mencapai 132,97 juta ha dimana 

seluas 122,94 juta ha adalah berupa tipe hutan 

lembap (moist forests) dan sisanya seluas 10,02 juta 

adalah tipe hutan kering (dry forests). Luas hutan di 

atas mencakup lebih dari 70,77% luas daratan 

Indonesia sementara sisanya diklasifikasikan 

sebagai herba sebesar 2,03%, areal budidaya 

sebesar 5,17% dan tutupan lahan lainnya sebesar 

22,03% (Anonim, 2022). 

Perbedaan angka-angka khususnya angka 

deforestasi dan degradasi hutan dari berbagai pihak 

seperti dijelaskan di atas, hingga saat ini belum 

banyak dikuantifikasi melalui analisis spasial. 

Untuk itu penelitian yang fokus pada analisis 

kesesuaian dan/atau ketidaksesuaian data dari 

berbagai sumber ini menjadi penting untuk 

dilakukan khususnya di Provinsi Kalimantan Timur 

yang merupakan salah satu Provinsi yang memiliki 

hutan tropis lembap terbesar di dunia. 

METODE PENELITIAN 

Lokasi Penelitian 

      Lokasi penelitian adalah areal kerja Unit 

Pelaksana Teknis Daerah Kesatuan Pengelolaan 

Hutan Produksi Telake (UPTD KPHP Telake) yang 

merupakan UPTD Dinas Kehutanan Provinsi 

Kalimantan Timur Keputusan seluas 240.915 

hektare berdasarkan Keputusan Menteri Kehutanan 

dan Lingkungan Hidup Nomor SK. 

560/MENLHK/SETJEN/PLA.0/6/2023 tanggal 06 

Juni 2023 tentang Penetapan Wilayah Kesatuan 

Pengelolaan Hutan Lindung dan Kesatuan 

Pengelolaan Hutan Produksi Provinsi Kalimantan 

Timur seperti disajikan pada Gambar 1. 

 
Gambar 1. Areal kerja Unit Pelaksana Teknis Daerah Kesatuan Pengelolaan Hutan Produksi Telake 
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Prosedur Penelitian 

Peta Penutupan Lahan Kementerian 

Lingkungan Hidup dan Kehutanan (KLHK) 

diperoleh dari Dinas Kehutanan Provinsi 

Kalimantan Timur dan Balai Pemantapan Kawasan 

Hutan dan Tata Lingkungan (BPKHTL) Wilayah 

IV Samarinda. 

Peta Penutupan Lahan (Peta PL) kemudian 

diunduh satu persatu mulai dari peta penutupan 

lahan tahun 2018 sampai dengan peta PL 2022 

Provinsi Kalimantan Timur. Pengolahan peta 

penutupan lahan pada penelitian ini menggunakan 

aplikasi pemetaan ArcGiS 10.8.1. 

Tropical Moist Forest (TMF Data) Pusat Penelitian 

Gabungan Komisi Eropa 

Data Tropical Moist Forest (Data TMF) 

keluaran Pusat Penelitian Gabungan Komisi Eropa 

dapat diunduh melalui link: 

https://forobs.jrc.ec.europa.eu/TMF/data kemudian 

dapat memilih Unduhan Data (Data Downloads) 

data yang dipilih. Misalkan kita memilih peta 

tutupan hutan di wilayah Provinsi Kalimantan 

Timur pada posisi akan terpilih lokasi yang 

disediakan yaitu dan E (Bujur Timur / Longitude) : 

110 derajat dan N (Lintang Utara / Latitude) : 0 

derajat atau 110 E, 0 N seperti pada Gambar 2. 

 
Gambar 2 Tampilan peta TMF yang akan diunduh 110 E, 0 N (kotak merah). 

Format data TMF yang diunduh berupa raster 

grid atau ubin (tiles) berukuran 10°x10° (1° = 

±111,32 km) dari peta. Dengan demikian luas 1 

(satu) ubin ±1.239.214,24 km2 (1.113,2 km x 

1.113,2 km). Klik ubin sesuai lokasi areal studi di 

menu pada tampilan gambar di atas, lalu akan 

muncul daftar kumpulan data yang tersedia. 

Masing-masing kumpulan data ini merupakan 

hyperlink ke file *.tif. 

Analisis Data 

Data Deforestasi dan Degradasi Hutan dari KLHK 

Langkah-langkah membuat peta Perubahan 

Penutupan Lahan : 

1) Peta Penutupan Lahan tahun 2018, 2019, 2020, 

2021, dan 2022 hasil unduhan dari KLHK 

dioverlay dan   dijadikan satu file dengan nama 

”Peta Penutupan Lahan 2018-2022”. 

2) ”Peta Penutupan Lahan 2018-2022” kemudian 

dianalisis perubahannya untuk setiap periode 

mengunakan 2 (dua) Peta Penutupan Lahan 

yang berpasangan, yaitu Perubahan Penutupan 

Lahan periode 2018-2019, 2019-2020, 2020-

2021, dan 2021-2022. 

3) Pada shapefile ”Peta Penutupan Lahan 2018-

2022” ditambahkan empat atribut bernama 

LCC18-19, LCC19-20, LCC20-21, LCC21-22. 

LCC adalah kependekan dari Land Cover 

Change. Untuk menambahkan atribut LCC 

pada ArcGIS, klik kanan pada Layer ”Peta 

Penutupan Lahan 2018-2022”  

4)  (Table of Content) lalu pilih Open Attribute 

Table → Table Options → Add Field → name 

diisi ”LCC18-19” → Type ”Text” → Field 

Properties : lenght ”5 sebagai kolom untuk 

menentukan kelas perubahan penutupan 

lahannya. Proses diulangi untuk LCC19-20, 

LCC20-21 dan LCC21-22. 

5) Langkah selanjutnya adalah mengisi kelas 

perubahan penutupan lahan dengan 

menggunakan skema perubahan penutupan 

lahan seperti tercantum pada Tabel 1 skema 

dinamika perubahan penutupan lahan. 

Tabel 1 Skema dinamika perubahan penutupan lahan 

 Hutan Alam 

Primer 

Hutan Alam 

Sekunder 

Non Hutan 

Hutan Alam Primer Stable Forest Forest 

Degradation 

Deforestation 
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Hutan Alam Sekunder Forest Gain Stable Forest Deforestation 

Non Hutan Forest Gain Forest Gain Stable Non 

Forest 

6) Untuk kelas Deforestasi hutan artinya 

perubahan kelas penutupan lahan dari hutan 

alam baik hutan primer maupun hutan 

sekunder menjadi kelas penutupan lahan 

non hutan. 

7) Untuk mengisi kelas perubahan penutupan 

lahan di atribut LCC pada ArcGIS, 

dilakukan dengan cara klik Selection → 

Select By Attributes → pilih layer : ”Peta 

Penutupan Lahan 2018-2022” → klik 

”LCC18-19” → pilih 2 (dua) periode tahun 

penutupan lahan yang ditumpangsusunkan 

(overlay) yaitu Identitas (ID) penutupan 

lahan tahun 2018 dari area yang terpilih 

yaitu ID kelas penutupan lahan yang 

merupakan Hutan Alam : Hutan Primer dan 

Hutan Sekunder (ID : 2001, 2002, 2005, 

20051, 2004, 2041) dan penutupan lahan 

tahun 2019 pilih ID kelas penutupan 

lahannya yang non hutan (ID : 2006, 2010, 

2007, 20071, 3000, 20091, 20092, 20093, 

20094, 2012, 20122, 2014, 20141, 5001, 

50011, 2500, 20121) disesuaikan dengan 

ID kelas yang terpilih. 

8) Secara teknis rumus (Query) Deforestasi 

adalah :  

 

9) Selanjutnya Area yang terpilih kemudian 

diberi nama “DEF” untuk kelas Deforestasi 

pada  

10) kolom ”LCC18-19” dengan cara : klik 

kanan pada kolom ”LCC18-19” pilih ”Field 

Calculator” → ketik “DEF” kemudian klik 

”OK”. 

11) Selanjutnya dibuat kelas Degradasi hutan 

artinya perubahan dari kelas penutupan 

lahan hutan alam primer (hutan lahan 

kering, hutan rawa dan hutan mangrove) 

menjadi kelas penutupan lahan hutan alam 

sekunder. 

12) Pada layar ArcGis klik Selection → Select 

By Attributes → Layer : Peta Penutupan 

Lahan 2018-2022 → klik ”LCC18-19” → 

pilih 2 (dua) peta penutupan lahan yang 

ditumpangsusunkan (overlay) untuk 

mewakili periode degradasi yaitu ID 

penutupan lahan tahun 2018 dan 2019. Dari 

penutupan lahan tahun 2018 dari area yang 

terpilih yaitu ID kelas penutupan lahan 

Hutan Alam Primer (ID : 2001, 2004, 2005) 

sementara pada penutupan lahan tahun 

2019, ID kelas penutupan lahannya yang 

menjadi Hutan Sekunder adalah ID : 2002, 

2041, 20051). 

13) Rumus (Query) untuk kelas Degradasi : 

 

Area yang terpilih kemudian diberi nama 

“DEG” untuk kelas Degradasi pada kolom 

”LCC18-19” dengan cara : klik kanan pada 

kolom ”LCC18-19” pilih ”Field 

Calculator” kemudian ketik “DEG” 

kemudian klik ”OK”. 

14) Proses dari angka 6 sampai 12 diulangi 

untuk periode perubahan penutupan lahan 

2019-2020, 2020-2021 dan 2021-2022. 

15) Langkah selanjutnya menggabungkan 

poligon-poligon yang terbentuk 

berdasarkan kelas deforestasi dan degradasi 

pada setiap perubahan kelas penutupan 

lahan menjadi satu buah poligon yang 

lengkap dan satu  

16) kesatuan. Caranya yaitu membuka kotak 

peralatan geoprosesing (Arc Toolbox) pada 

panel ArcGis : Arc Toolbox → Data 

Management Tool → Generalization → 

Dissolve. 

17) Setelah poligon kelas deforestasi dan kelas 

degradasi terbentuk, kemudian dilakukan 

perhitungan luas masing kelas yaitu 

menambahkan kolom dengan cara : Add 

("PL18_ID" = 2001 OR "PL18_ID" = 2004 OR "PL18_ID" = 2005 ) AND ( "PL19_ID" = 

2002 OR "PL19_ID" = 20041 OR "PL19_ID" = 20051 ) 

 

("PL18_ID" = 2001 OR "PL18_ID" = 2004 OR "PL18_ID" = 2005 ) AND ( "PL19_ID" = 2002 

OR "PL19_ID" = 20041 OR "PL19_ID" = 20051 ) 

 

("PL18_ID" = 2001 OR "PL18_ID" = 2004 OR "PL18_ID" = 2005 ) AND ( "PL19_ID" = 2002 

OR "PL19_ID" = 20041 OR "PL19_ID" = 20051 ) 

 

("PL18_ID" = 2001 OR "PL18_ID" = 2004 OR "PL18_ID" = 2005 ) AND ( "PL19_ID" = 2002 

OR "PL19_ID" = 20041 OR "PL19_ID" = 20051 ) 

 

("PL18_ID" = 2001 OR "PL18_ID" = 2004 OR "PL18_ID" = 2005 ) AND ( "PL19_ID" = 2002 

OR "PL19_ID" = 20041 OR "PL19_ID" = 20051 ) 
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Field → Name : Luas Ha → Type : Double 

→ Field Properties : 20. 

18) Pada kolom Luas Ha klik kanan → 

Calculate Geometry → Property : Area → 

Coordinate System : WGS 1984 UTM Zone 

50S → Unit : Hectares (ha) → OK, maka 

data atribut luas deforestasi dan luas 

degradasi telah terjumlah. 

Data Deforestasi dan Degradasi Hutan dari TMF 

(Tropical Moist Forest) 

Peta Perubahan Tutupan Hutan di Hutan Tropis 

Lembap versi Pusat Penelitian Gabungan Komisi 

Eropa (The European Commissions Joint Research 

Center) merupakan peta dengan format raster 

(*.tif). Kelas tutupan hutan deforestasi dan 

degradasi dapat diunduh di peta tahun deforestasi 

(Deforestation year) mulai dari periode tahun 1982-

2022 maupun peta tahun degradasi hutan 

(Degradation year) mulai dari periode tahun 1982-

2022. Peta tersebut dapat dipilih sesuai dengan 

keperluan. 

Langkah-langkahnya : 

1) Melalui mesin pencarian (Google Chrome) 

dengan mengisi : 

https://forobs.jrc.ec.europa.eu/TMF/data 

→ Data Downloads → Downloads Process 

→ pilih ubin yg berukuran 10° x 10° → 

pilih Degradation year → dalam data 

tersebut tersedia peta degradasi hutan mulai 

dari tahun 1982 sampai dengan tahun 2022. 

Langkah untuk mengunduh peta deforestasi 

dengan cara 

https://forobs.jrc.ec.europa.eu/TMF/data 

→ Data Downloads → Downloads Process 

→ pilih ubin yg berukuran 10° x 10° → 

pilih Deforestation year (tersedia data 

deforestasi mulai dari tahun 1982 sampai 

dengan tahun 2022). 

2) Hasil unduhan peta TMF tersebut berupa 

data raster dengan format ”.tif” kemudian 

kita buka di ArcGIS. Contoh data peta TMF 

tahun deforestasi : 

(JRC_TMF_DeforestationYear_INT_1982

_2022_ v1_ASI_ID40_N0_E110.tif) 

Setelah peta TMF tersebut dibuka di 

ArcGIS, dapat dilihat area tahun 

terdeforestasi dengan cara : Klik dua kali 

Peta tahun deforestasi TMF tadi → 

Symbology → Unique value → Ok, telah 

tersedia data peta tahun deforestasi mulai 

tahun 1982 sampai dengan tahun 2022. 

Demikian juga untuk peta tahun degradasi hutan 

hasil unduhannya yaitu : 

(JRC_TMF_DegradationYear_INT_1982_2022_v1

_ASI_ID40_N0_E110.tif). 

Untuk menghitung luas peta raster (.tif) , ada 

beberapa cara antara lain :  

3) Mengubah peta raster (.tif) ke peta vector : 

a) Terlebih dahulu peta TMF dipotong 

berdasarkan area pengamatan yaitu 

dengan mnambahkan peta ”Add Data” 

peta raster (TMF) yang akan dipotong 

di Layer baru pada ArcGis. 

b) Tambahkan juga Layer peta area 

pengamatan 

c) Klik Arc Toolbox → Data Mangement 

Tools → Raster → Raster Processing 

→ Clip (klik dua kali) : Input Raster 

(masukkan peta raster/TMF), Output 

Extent (masukkan peta area 

pangamatan sebagai pemotong), 

centang (use input features for 

Clipping Geometry) → OK 

d) Akan terbentuk Layer baru peta raster 

(TMF) dalam area pengamatan. 

e) Layer baru yang terbentuk masih 

dalam bentuk peta raster (.tif) harus 

dirubah terlebih dahulu dalam bentuk 

peta vector agar bisa dihitung luas area 

atau poligonnya. 

f) Cara mengubah peta raster ke peta 

dalam bentuk vector adalah : Arc 

Toolbox → Conversion Tools → From 

Raster → Raster to Polygon : - Input 

raster (isi raster yang akan dikonversi) 

- Field (optional) : Value – Output 

polygon features (jangan dirubah) → 

OK, maka akan terbentuk Layer baru 

yang berisi data vector berupa poligon-

poligon. 

g) Kemudian poligon-poligon tersebut 

kita gabungkan berdasarkan kelasnya 

menjadi satu kesatuan yang utuh 

dengan cara : Geoprocessing → 

Dissolve : - Input Features (Layer baru 

yang dibuat tadi), Output Feature 

Class (jangan dirubah), Dissolve 

Field(s) (optional) pilih/centang 

gridcode → OK, maka akan terbentuk 

Layer baru lagi yang berisi masing-

masing kelas. 

h) Untuk menghitung luas masing-

masing kelas, dari tabel harus 

membuat kolom baru dengan cara : 

Klik kanan Layer yang berisi masing-

masing kelas Open Attribute Table → 

Add Field : Name (Luas_Ha), Type 

(Double) → OK. Kemudian kolom 

yang baru dibuat (Luas_Ha) di Klik 

kanan → Calculate Geometry : 

Property (Area), Use coordinate 

system of the date frame (PCS : WGS 
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1984 UTM Zone 50S, Units (Hectares 

[ha]) → OK, maka akan terbentuk luas 

masing-masing kelas. 

      Hasil pengolahan data deforestasi dan degradasi 

hutan dari KLHK dan TMF akan ditumpangsusun 

sehingga diketahui mana areal deforestasi dan 

degradasi hutan yang sama di kedua data dan mana 

areal deforestasi dan degradasi hutan yang tidak 

beririsan di kedua data pada setiap periode 

pengamatan. Luas area deforestasi dan degradasi 

hutan  yang beririsan atau sama maupun yang tidak 

sama akan dihitung luasannya dan dikompilasi ke 

dalam tabel. 

Analisis Laju Deforestasi dan Degradasi Hutan 

    Untuk menghitung laju deforestasi dan degradasi 

hutan digunakan rumus yang dijelaskan oleh 

Dariono dkk. (2018) sebagai berikut : 

Laju deforestasi tahunan digunakan rumus : 

 

r=
𝑨𝟏-𝑨𝟐

𝒕𝟐 − 𝒕𝟏
 

Keterangan : 

 r  = Laju deforestasi (ha/tahun) 

A1 = Luas hutan pada waktu awal 

A2 = Luas hutan pada waktu akhir 

t1  = Tahun pada waktu awal 

t2  = Tahun pada waktu akhir 

Persentase laju deforestasi tahunan dengan rumus  

𝐕 =
(𝑨𝟏 − 𝑨𝟐 )/ (𝒕𝟐 − 𝒕𝟏  )

𝑨𝟏
 𝑿 𝟏𝟎𝟎 % 

Keterangan : 

V  = Laju deforestasi (%/tahun) 

A1 = Luas hutan pada waktu awal 

A2 = Luas hutan pada waktu akhir 

t1  = Tahun pada waktu awal 

t2  = Tahun pada waktu akhir 

 

Akurasi Data Deforestasi dan Degradasi tahun 

2022 

      Untuk mengetahui tingkat akurasi data 

deforestasi dan degradasi hutan khususnya di tahun 

yang terbaru yakni tahun 2022, akan disiapkan total 

180 titik pengamatan di wilayah studi yakni areal 

kerja UPTD KPHP Telake, dengan distribusi sesuai 

kategori berikut: 

1. Sebanyak masing-masing 30 titik 

pengamatan yang mewakili areal 

terdeforestasi versi data. 

2. Sebanyak masing-masing 30 titik 

pengamatan yang mewakili areal 

terdeforestasi versi data. 

3. Sebanyak 30 titik pengamatan yang yang 

mewakili areal terdeforestasi versi data 

KLHK dan data TMF yang beririsan. 

4. Sebanyak masing-masing 30 titik 

pengamatan yang mewakili areal hutan 

terdegradasi versi data KLHK. 

5. Sebanyak masing-masing 30 titik 

pengamatan yang mewakili areal hutan 

terdegradasi versi data TMF. 

6. Sebanyak 30 titik pengamatan yang yang 

mewakili areal hutan terdegradasi versi data 

KLHK dan data TMF yang beririsan. 

Titik-titik pengamatan akan disebar secara acak 

pada setiap kategori di atas. Pada ArcGIS, 

pengacakan titik pengamatan dilakukan dengan cara 

pilih Arc Toolbox → Data Management Tool → 

Sampling → Create Random Point. 

Citra SkySat akan digunakan sebagai bahan untuk 

menilai apakah benar telah terjadi deforestasi 

ataupun degradasi hutan pada setiap titik 

pengamatan. Citra SkySat merupakan citra resolusi 

tinggi keluaran dari Planet Labs dengan resolusi 5 

meter. 

HASIL DAN PEMBAHASAN 

Berdasarkan hasil analisis peta terhadap 

deforestasi dan degradasi peta versi Kementerian 

Lingkungan Hidup dan Kehutanan (KLHK) dan 

peta versi Tropical Moist Forest (TMF) periode 

tahun 2018-2019, 2019-2020, 2020-2021, dan 

2021-2022 diperoleh data sebagai berikut : 

 

Deforestasi versi Peta KLHK 

Deforestasi di kawasan hutan UPTD KPHP 

Telake pada periode tahun 2018-2019 seluas ±42,59 

hektare, meningkat pada periode tahun 2019-2020 

menjadi seluas ±672,90 hektare. Pada periode tahun 

2020-2021 luas deforestasi versi peta KLHK 

menurun menjadi seluas ±61,05 hektare. Kemudian 

pada periode tahun 2021-2022 deforestasi versi peta 

KLHK tidak terdapat adanya deforestasi di kawasan 

hutan UPTD KPHP Telake berdasarkan data dari 

versi peta KLHK. 

Luas deforestasi versi peta KLHK periode 

2018-2019, tidak terdapat area yang beririsan 

dengan peta deforestasi versi peta TMF tahun 2019. 

Luas deforestasi versi peta KLHK periode 2019-

2020 terdapat area yang beririsan dengan peta 

deforestasi versi peta TMF tahun 2020 yaitu seluas 

±0,26 hektare. Luas deforestasi versi peta KLHK 

periode 2020-2021 juga terdapat area yang beririsan 

dengan versi peta TMF tahun 2021 yaitu seluas 

±0,009 hektare. Sedangkan luas deforestasi versi 



Ulin - J Hut Trop  9 (1):325-336     pISSN 2599 1205, eISSN 2599 1183 

September 2025       DOI: http://dx.doi.org/10.32522/ujht.v9i2.17513 

331  
  

 

peta KLHK periode 2021-2022 tidak terdapat area 

yang beririsan dengan peta deforestasi versi peta 

TMF tahun 2022. 

Luas deforestasi versi peta KLHK periode 

tahun 2018-2019 yang tidak beririsan dengan versi 

peta TMF seluas ±42,59 hektare. Sedangkan luas 

deforestasi versi peta KLHK periode tahun 2019-

2020 yang tidak beririsan dengan versi peta TMF 

seluas ±672,64 hektare. Luas deforestasi versi peta 

KLHK periode tahun 2020-2021 yang tidak 

beririsan dengan versi peta TMF seluas ±61,04 

hektare. Selanjutnya luas deforestasi versi peta 

KLHK periode tahun 2021-2022 tidak terdapat area 

yang tidak beririsan dengan versi peta TMF pada 

tahun 2022. 

Deforestasi versi Peta TMF 

Data deforestasi di kawasan hutan UPTD 

KPHP Telake berdasarkan versi peta TMF pada 

tahun 2019 seluas ±47,73 hektare, menurun pada 

tahun 2020 menjadi seluas ±16,14 hektare. 

Kemudian deforestasi versi peta TMF pada tahun 

2021 meningkat menjadi seluas ±41,67 hektare. 

Selanjutnya pada periode tahun 2022 deforestasi 

versi peta TMF menurun menjadi seluas ±25,00 

hektare. 

Luas deforestasi versi peta TMF pada tahun 

2019 yang tidak beririsan dengan peta deforestasi 

versi peta KLHK periode 2018-2019 seluas ±47,73 

hektare. Luas deforestasi versi peta TMF tahun 

2020 yang tidak beririsan dengan peta deforestasi 

versi peta KLHK periode 2019-2020 seluas ±15,88 

hektare. Luas deforestasi versi peta TMF tahun 

2021 yang tidak beririsan dengan peta peta KLHK 

periode 2020-2021 seluas ±41,66 hektare. 

Sedangkan luas deforestasi versi peta TMF tahun 

2022 yang tidak beririsan dengan peta deforestasi 

versi peta KLHK (deforestasi versi peta KLHK 

periode 2021-2022 tidak ada data), yaitu seluas 

±25,00 hektare. Deforestasi versi peta KLHK dan 

deforestasi versi peta TMF disajikan pada Tabel 3 

dan Gambar 3. 

Tabel 3 Deforestasi KLHK dan Deforestasi TMF 2018-2022 

 

Periode 

Luas 

deforestasi 

versi KLHK 

(Ha) 

Luas 

deforestasi 

versi TMF 

(Ha) 

Luas 

deforestasi 

yang beririsan 

versi KLHK 

dan TMF 

(ha) 

Luas 

deforestasi 

yang tidak 

beririsan versi 

KLHK 

(ha) 

Luas 

deforestasi 

yang tidak 

beririsan versi 

TMF (ha) 

2018-2019 42,59 47,73 0 42,59 47,73 

2019-2020 672,90 16,14 0,26 672,64 15,88 

2020-2021 61,05 41,67 0,009 61,04 41,66 

2021-2022 0 25,00 0 0 25,00 

 

Gambar 3. Grafik luas deforestasi KPHP Telake 2018-2022 
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Degradasi Hutan versi Peta KLHK 

      Degradasi hutan di kawasan hutan UPTD KPHP 

Telake berdasarkan peta versi peta KLHK pada 

tahun 2018-2019 tidak terdapat degradasi hutan. 

Degradasi hutan pada tahun 2019-2020 seluas 

±64,59 hektare. Kemudian pada tahun 2020-2021 

tidak terdapat degradasi hutan, demikian juga pada 

periode tahun 2021-2022 tidak terdapat degradasi 

hutan versi peta KLHK. 

 

Degradasi Hutan versi Peta TMF 

      Data degadasi hutan di kawasan hutan UPTD 

KPHP Telake berdasarkan versi peta TMF pada 

tahun 2019 seluas ±293,55 hektare, menurun pada 

tahun 2020 menjadi seluas ±109,00 hektare. 

Kemudian degradasi hutan versi peta TMF pada 

tahun 2021 menurun kembali menjadi seluas ±54,00 

hektare. Pada tahun  2022 degradasi hutan versi peta 

TMF meningkat menjadi seluas ±93,00 hektare. 

Tabel 4 dan Gambar 4 menyajikan degradasi hutan 

versi KLHK dan degradasi hutan versi TMF. 

 

Gambar 4. Grafik luas degradasi hutan KPHP Telake 2018-2022 

 

Tabel 4. Degradasi hutan KLHK dan degradasi hutan TMF 2018-2022 

 

 

Periode 

Luas 

degradasi 

versi KLHK 

(Ha) 

Luas 

degradasi 

versi 

TMF 

(Ha) 

Luas Degradasi 

yang beririsan 

versi KLHK dan 

TMF 

(Ha) 

Luas 

degradasi 

yang tidak 

beririsan 

versi KLHK 

(Ha) 

Luas 

degradasi 

yang tidak 

beririsan versi 

TMF 

(Ha) 

2018-2019 0 293,55 0 0 293,55 

2019-2020 64,59 109,00 0 64,59 109,00 

2020-2021 0 54,00 0 0 54,00 

2021-2022 0 93,00 0 0 93,00 

Laju Deforestasi dan Degradasi Hutan 

Berdasarkan hasil analisis data yang diperoleh 

dari perhitungan laju deforestasi tahunan (periode 

2018-2022) versi peta KLHK adalah sebesar 194 

hektare per tahun (0,08% per tahun), sedangkan 

versi peta TMF adalah sebesar 33 hektare per tahun 

(0,01% per tahun). 

Laju degradasi hutan tahunan (periode 2018-

2022) vesi peta KLHK sebesar 16 hektar per tahun 

(0,01% pertahun) dan laju degradasi hutan versi 

peta TMF sebesar 137 hektare per tahun (0,06% per 

tahun). 
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Pengamatan area terdeforestasi dan 

terdegradasi 

Pengamatan area terdeforestasi dan 

terdegradasi dilakukan menggunakan citra satelit 

SkySat keluaran Planet Labs dengan citra resolusi 

tinggi (5 m) pada liputan bulan Juni 2020 dan bulan 

Desember 2022. 

Sebanyak 30 titik pengamatan yang mewakili 

areal terdeforestasi versi peta KLHK namun tidak 

beririsan (periode tahun 2020-2021), yang disajikan 

pada Tabel 5 berikut. 

Tabel 5. Titik pengamatan yang mewakili area terdeforestasi versi peta KLHK (periode tahun 2020-2021) 

 

No. 

Titik 

Koordinat 

Titik 

Pengamatan 

Pengamatan pada 

Citra SkySat tahun 2020 dan tahun 2022 

1. 

 

115° 52' 26,640" E 

1° 23' 20,490" S 

 

 

 

 

1 A.  Juni 2020 

 

 

 

 

 

 

 

 

 

 

 

 

B. Desember 2022 

 

2. 116° 0' 8,328" E 

1° 35' 18,165" S 

 

2 A. Juni 2020 

 

 

 

 

 

 

 

 

 

 

 

B. Desember 2022 

 

3. 115° 59'57,979" E 

1° 15' 49,700" S 

 

5 

4. 

 

115° 59' 49,952" E 

1° 15' 56,489" S 

 

15 

5. 116° 0' 8,825" E 

1° 15' 47,525" S 

17 

6. 116° 0' 7,428" E 

1° 15' 48,951" S 

 

3 A. Juni 2020 

 

 

 

 

 

 

 

 

 

 

 

 

 

B. Desember 2022 

 

7. 116° 0' 3,245" E 

1° 15' 50,384" S 

4 

8. 115° 39' 3,457" E 

1° 36' 6,176" S 

7 

9. 115° 39' 3,555" E 

1° 36' 1,450" S 

12 

10. 115° 39' 10,914" E 

1° 36' 0,184" S 

16 

11. 115° 40' 33,986" E 

1° 36' 11,710" S 

20 

12. 115° 40' 32,193" E 

1° 36' 15,679" S 

21 

13. 115° 40' 38,118" E 

1° 36' 8,175" S 

23 
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No. 

Titik 

Koordinat 

Titik 

Pengamatan 

Pengamatan pada 

Citra SkySat tahun 2020 dan tahun 2022 

14. 115° 40' 37,171" E 

1° 36' 7,699" S 

25  

 

 

 

 

15. 115° 39' 36,143" E 

1° 35' 19,500" S 

26 

16. 115° 59' 54,581" E 

1° 15' 48,852" S 

27 

17. 115° 59' 49,863" E 

1° 15' 45,309" S 

28 

18. 115° 51' 8,406" E 

1° 38' 34,317" S 

6 A. Juni 2020 

 

 

 

 

 

 

 

B. Desember 2022 

 

19. 115° 51' 7,173" E 

1° 38' 30,154" S 

8 

20. 115° 50' 44,710" E 

1° 38' 49,900" S 

9 

21. 115° 50' 45,555" E 

1° 38' 48,506" S 

24 

22. 115° 50' 51,128" E 

1° 38' 43,894" S 

 

29 

23. 115° 59' 12,850" E 

1° 15' 10,252" S 

 

 
 

 

10 A. Juni 2020 

 

 

 

 

 

B. Desember 2022 

 

24. 115° 58' 58,493" E 

1° 15' 22,007" S 

 

14 

25. 115° 51' 20,448" E 

1° 28' 49,043" S 

 

 

11 Juni 2020 

 

B. Desember 2022 

 

26. 115° 51' 21,325" E 

1° 28' 43,987" S 

 

13 

27. 115° 39' 4,819" E 

1° 36' 2,958" S 
18 Juni 2020 

 

 

 

 

 

B. Desember 2022 
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No. 

Titik 

Koordinat 

Titik 

Pengamatan 

Pengamatan pada 

Citra SkySat tahun 2020 dan tahun 2022 

28. 115° 52' 19,587" E 

1° 23' 24,034" S 
19 A. Juni 2020 

 

 

 

 

 

 

B. Desember 2022 

29. 115° 52' 26,252" E 

1° 23' 20,491" S 
22 

30. 115° 52' 19,855" E 

1° 23' 22,729" S 

30 

 
KESIMPULAN  

 

Angka deforestasi periode tahun 2018-2019 

versi peta KLHK menunjukkan bahwa angka 

deforestasi yaitu seluas ±42,59 hektare, sedangkan 

angka deforestasi versi peta TMF yaitu seluas 

±47,73 hektare, lebih tinggi angka deforestasi versi 

peta TMF sebesar ±5,14 hektare. Luas deforestasi 

periode tahun 2019-2020 versi peta KLHK seluas 

±672 dan versi peta TMF seluas ±16,14 lebih tinggi 

angka deforestasi versi peta KLHK ±656,76 

hektare. Deforestasi periode tahun 2020-2021 versi 

peta KLHK seluas ±61,05, sedangkan luasan 

deforestasi versi peta TMF seluas ±41,67 hektare, 

lebih tinggi ±19,38 hektare angka deforestasi versi 

peta KLHK. Deforestasi periode tahun 2021-2022 

versi peta KLHK tidak terdapat area deforestasi, 

sedangkan angka deforestasi versi peta TMF adalah 

seluas ±25,00 hektare. Degradasi hutan versi peta 

KLHK periode tahun 2018-2019 tidak terdapat area 

yang terdegradasi. Sedangkan degradasi hutan versi 

peta TMF seluas ±293,55 hektare. Luas degradasi 

hutan versi peta KLHK periode tahun 2019-2020 

seluas ±64,59 hektare, luas  degradasi hutan versi 

peta TMF seluas ±109,00 hektare, lebih tinggi 

±44,41 hektare angka degradasi hutan versi peta 

TMF.  Degradasi hutan versi peta KLHK periode 

tahun 2020-2021 tidak terdapat area terdegrdasi, 

sedangkan luas degradasi hutan versi peta TMF 

yaitu seluas ±54,00 hektare. Degradasi hutan versi 

peta KLHK periode tahun 2021-2022 tidak terdapat 

area terdegradasi, sedangkan luas degradasi hutan 

versi peta TMF seluas ±93,00 hektare. 

 

Laju Deforestasi dan degradasi hutan tahunan 

(periode 2018-2022) versi peta KLHK adalah 

sebesar 194 hektare per tahun (0,08% per tahun), 

sedangkan versi peta TMF adalah sebesar 33 

hektare per tahun (0,01% per tahun). Laju degradasi 

hutan tahunan (periode 2018-2022) vesi peta KLHK 

sebesar 16 hektare per tahun (0,01% pertahun) dan 

laju degradasi hutan versi peta TMF sebesar 137 

hektare per tahun (0,06% per tahun). 
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